4-1-1993

Contact lens solutions: a microsoft works database

Robert J. Crammer

Pacific University

Recommended Citation

https://commons.pacificu.edu/opt/1047

This Thesis is brought to you for free and open access by the Theses, Dissertations and Capstone Projects at CommonKnowledge. It has been accepted for inclusion in College of Optometry by an authorized administrator of CommonKnowledge. For more information, please contact CommonKnowledge@pacificu.edu.
Contact lens solutions: a microsoft works database

Abstract
This paper describes the use of the Macintosh version of Microsoft Works as it applies to a database of contact lens solutions. This printed guide is supplied in addition to the actual computer database to point out those features of Works which prove to be most useful with this specific database.

The database, if periodically maintained and updated, might be used as a reference in both the clinical and academic setting. While ongoing database updates will not be provided by this author, all current existing data has been compiled in a widely available, relatively inexpensive and adaptable database program. Therefore, periodic adjustments to an individual database is possible as solution formulas change or new products become available.

Degree Type
Thesis

Rights
Terms of use for work posted in CommonKnowledge.

This thesis is available at CommonKnowledge: https://commons.pacificu.edu/opt/1047
Copyright and terms of use

If you have downloaded this document directly from the web or from CommonKnowledge, see the “Rights” section on the previous page for the terms of use.

If you have received this document through an interlibrary loan/document delivery service, the following terms of use apply:

Copyright in this work is held by the author(s). You may download or print any portion of this document for personal use only, or for any use that is allowed by fair use (Title 17, §107 U.S.C.). Except for personal or fair use, you or your borrowing library may not reproduce, remix, republish, post, transmit, or distribute this document, or any portion thereof, without the permission of the copyright owner. [Note: If this document is licensed under a Creative Commons license (see “Rights” on the previous page) which allows broader usage rights, your use is governed by the terms of that license.]

Inquiries regarding further use of these materials should be addressed to: CommonKnowledge Rights, Pacific University Library, 2043 College Way, Forest Grove, OR 97116, (503) 352-7209. Email inquiries may be directed to: copyright@pacificu.edu

This thesis is available at CommonKnowledge: https://commons.pacificu.edu/opt/1047
CONTACT LENS SOLUTIONS:
A Microsoft Works® Database

A Thesis
Submitted to the Faculty
of
Pacific University College of Optometry

by
Robert J. Crammer

In partial fulfillment
of the Requirements for the Degree
Doctor of Optometry
Spring 1993
Contact Lens Solutions:
A Microsoft Works® Database

Cristina M. Schnider, O.D.
Thesis Advisor

Robert J. Crammer
Acknowledgment

I would like to express my thanks to Dr. Cristina Schnider for her help and suggestions with this project. Additional thanks go to Dr. Leonard Levine for his recommendations.
Biography of
Robert Crammer

I graduated from The University of Kansas in 1984 with a Bachelor of Science degree in Biology. I graduate from Wichita State University with a Bachelor of Health Science degree in 1986. I currently belong to the following organizations: Beta Sigma Kappa Optometric Honor Fraternity; Pi Kappa Phi Fraternity; American Optometric Association; American Academy of Physician Assistants; and the Colorado Academy of Physician Assistants.
Trademark Acknowledgments

Microsoft, Microsoft Works and Works are registered trademarks of Microsoft, Inc.
ABSTRACT

This paper describes the use of the Macintosh version of Microsoft Works as it applies to a database of contact lens solutions. This printed guide is supplied in addition to the actual computer database to point out those features of Works which prove to be most useful with this specific database.

The database, if periodically maintained and updated, might be used as a reference in both the clinical and academic setting. While ongoing database updates will not be provided by this author, all current existing data has been compiled in a widely available, relatively inexpensive and adaptable database program. Therefore, periodic adjustments to an individual database is possible as solution formulas change or new products become available.
METHODOLOGY

The Microsoft Works Contact Lens Solutions Database was designed as a fourth year thesis project at Pacific University College of Optometry. The following information is included in the database:

1. The name of the company which manufactures the product.
2. The name of the product.
3. The solution category to which the product belongs.
4. The preservatives used in the product.
5. The other ingredients contained in the product.
6. The category of lenses for which the product is to be used.
7. The care regimen to which the product belongs, if applicable.
8. The starter kit to which the product belongs, if applicable.
9. Additional comments, if applicable.
10. Approved lens materials for the product, if applicable.
11. Additional products intended to be used with the product, if applicable.
INTRODUCTION

In the interest of optimum care for contact lens patients, optometrists are expected to be, and should be, the authority on matters concerning not only lens material and design but also the products that are used to care for the lenses. Too often clinicians become preoccupied with lens parameters or fitting techniques while little emphasis is placed on the products used by the patient for daily cleaning, weekly cleaning and disinfection of those lenses. Obviously, even the most exacting and diligent of lens fittings will be of little value to someone who subsequently develops difficulties due to lens cleaning and disinfection procedures.

In regard to contact lens solutions, many of the difficulties encountered in the clinical setting often stem from poor patient education and resulting noncompliance. Also, there can be misuse of solutions or patient intolerance to solution ingredients. In some cases there might be more than one of these problems co-existing in the same patient.

Currently, there are many care products available for contact lenses and many more are destined to be marketed in the future. As if it weren’t already confusing enough, this continued proliferation of lens-care products will inevitably be more and more bewildering to patients and doctors. Adding to the existing confusion is the inherent nature of the marketplace itself. With the high prices charged for lens-care products, patients are naturally tempted to purchase whatever costs less even if the low-cost item is not appropriate for them. Clearly, there is a need for optometrists to be the authority to which patients can turn for accurate information concerning what lens care products are available, appropriate and suitable for their particular situation.

Any patient who has been fitted with contact lenses must be educated as to what solutions they may or may not use. To do this, the dispenser must have adequate knowledge of individual products so as to advise the patient whether one solution might be substituted for another.
While the task of becoming familiar with the myriad of lens-care products available is formidable at present, it is, unfortunately, destined only to become more so in the future. But regardless of how difficult it may become, knowledge of these lens-care products is a responsibility which optometrists must assume.

Fortunately, computers lend themselves readily to sorting, accessing and retrieving particular portions of information from large sets of data. This is exactly the kind of systematic ordering that is needed for contact lens solutions. Computer database programs such as Microsoft Works allow large quantities of detailed information to organized for just this sort of record maintenance. Moreover, Works databases are easily expanded and can be redesigned to accommodate changing data.

Another major advantage of database programs such as Works lies in their ability to search, selectively recall and extract particular sets of data from what would otherwise be an unmanageable volume of information. The benefits of having such data immediately accessible in the clinical setting are many. Aside from improving the overall organization and efficiency of the optometric office, the database would allow for quick identification of other potentially unsuccessful care regimens based upon known patient sensitivities.
MICROSOFT WORKS FEATURES

Statement

This description of Microsoft Works features is designed to be brief and very user-specific for the Contact Lens Solutions Database. Only the most routine and important of commands will be described here in order to make the data accessible to those who may not be familiar with computer databases in general or Microsoft Works in particular. While the procedures for both insertion of new data entries and deletion of existing data entries will be described, the same procedures as they apply to fields will not be discussed. Inherent with insertions, deletions or any similar changes in the type-characteristics of fields is the risk of producing disastrous database errors, including permanent erasure of some or all of the existing data. Those desiring to make such radical changes to the database would be, effectively, recreating their own version of this database and would be referred to the Microsoft Works users' manual for a complete description of available commands and their use.

Opening the Database

If the Solutions Database is contained on a diskette then the easiest way to open and view the records, after inserting the database diskette into the drive slot and opening the disk, is to double-click the database icon. As long as the computer in use has Microsoft Works residing on its hard drive, the database will load automatically. Alternatively, if Microsoft Works is already running on the computer, simply select the “Open” command from the “File” menu. The database is called CLSD and will be loaded by simply double-clicking the mouse on its name in the dialog box or by first highlighting the name CLSD and then single-clicking the “Open” button.
Display Options

There are two screen formats which can be used to display data contained in Works files. First, there is the form format which was designed to be the display format observed when the Solutions Database loads. (See Figure 1). If the database did not initially display the form format, it is possible to switch to this format by selecting the “Show Form” option from the “Format” menu or, by pressing “Command-L” on the keyboard. “Command-L” will allow you to toggle between the two display options. In the form-display format, Works shows each database record individually among a series of records. This is the format which most easily allows database record contents to be entered and edited. By simply highlighting the desired field on the screen, that field’s contents then becomes visible in the data entry bar at the top of the computer display. Once this has been done, information can then be inserted, deleted or edited as will be described shortly. The contact lens solutions database contains 12 different fields into which data may be entered in this manner.

The second manner in which Works data may be displayed is the list format. (See Figure 2). In this format, the data is displayed in a manner much as it would appear in a phone book. A topic heading is located at the top of its appropriate column and below it are located multiple text entries with each row corresponding to a separate record in the database. Each column heading, on the other hand, ends up corresponding to its appropriate field category. The number of entries that Works is able to display in this format is limited only by the size of the computer screen. To activate the list-display format, highlight the “Show List” option from the “Format” menu or, as before, press “Command-L” on the keyboard. The horizontal and vertical scroll bars can then be used to move through the data and display records that are not in the current screen display.
| COMPANY | ALCON |
| SOLUTION | ADAPETTES |
| SOLUTION CATEGORY | LUBRICANT/REWETTING |
| PRESERVATIVES | EDTATE DISODIUM; SORBIC ACID |
| INGREDIENTS | NOT SPECIFIED |
| INGREDIENTS | |
| LENS CATEGORY | SOFT AND RIGID LENSES |
| CARE SYSTEM | SOACLENS CHEMICAL DISINFECTION |
| STARTER KIT | SOACLENS KIT |
| COMMENTS | |
| APPROVAL | |
| ADDITIONAL PRODUCTS | |
Editing, Inserting and Deleting Database Records

As with all software programs and data, it is best to make backup and working copies of the originals. This should be done before proceeding with the following descriptions for changing the database records.

Editing Records in the Current Database

The contents of any record may, at any time, be edited in either of the display formats. As previously mentioned, it is usually easiest to edit individual records while in the form-display format. After locating the record to be edited, the particular data field can be selected by pointing and clicking the mouse on it. This will cause that field to appear highlighted on the screen and the contents of that field will then be displayed in the data entry bar located at the top of the database display. It is in the entry bar where the desired changes can be made to the existing contents. After the changes have been correctly typed into the entry bar, pressing “Return” will transfer the updated information from the entry bar to the previously selected field. To retain such edited entries, the entire database will need to be saved on the disk copy by selecting the “Save” option under the “Edit” menu.

Inserting Records into the Current Database

As mentioned earlier, Works has flexibility that allows additional records to be added as product formulas change or new products become available. There are two ways in which records may be added to those already existing.

The first method involves simply entering the data into its appropriate field category anywhere in the database records, in either display format. After this is done, the records can again be arranged by using the “Sort” command under the “Organize” menu. To begin this rearrangement of data, first toggle to the list display format if necessary and then highlight the entire “Company” field column by clicking once on that column heading. After the entire column is highlighted, select the “Sort” command. Works will then display a submenu that will allow the sorting parameters to be defined. The
<table>
<thead>
<tr>
<th>COMPANY</th>
<th>SOLUTION</th>
<th>PRESERVATIVES</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOBOB</td>
<td>HARD CONTACT LENS CLEANER</td>
<td>NONE</td>
</tr>
<tr>
<td>LOBOB</td>
<td>HARD CONTACT LENS CLEANER/OXYGEN DISINFECTING/</td>
<td>BENZYL ALCOHOL; TRISODIUM EDTATE</td>
</tr>
<tr>
<td>LOBOB</td>
<td>SOAKING SOLUTION</td>
<td>EDETATE DISODIUM; BENZALKONIUM CHLORIDE</td>
</tr>
<tr>
<td>LOBOB</td>
<td>LOBOB SOFT CLEANER</td>
<td>EDTA; SORBIC ACID</td>
</tr>
<tr>
<td>LOBOB</td>
<td>LOBOB STERILE SALINE</td>
<td>NONE (AEROSOL)</td>
</tr>
<tr>
<td>LOBOB</td>
<td>SOAKING SOLUTION</td>
<td>EDETATE DISODIUM; BENZALKONIUM CHLORIDE</td>
</tr>
<tr>
<td>LOBOB</td>
<td>WETTING/REWETTING SOLUTION</td>
<td>BENZYL ALCOHOL; SORBIC ACID; TRISODIUM EDTATE</td>
</tr>
</tbody>
</table>
database is currently sorted by manufacturer from A to Z. By clicking on the OK button, the newly inserted entry will be sorted into its appropriate place.

A second method of inserting records involves picking out exactly where the record is to be inserted while Works is in the list-display mode. Once it has been determined where the new record is to be inserted, select the record immediately below that location and use the "Insert Record" command from the "Edit" menu (or press "Command-I" on the keyboard). When this command is executed, a blank row will be created and the new entry may be typed into its appropriate location. No additional sorting will be needed if this method of data insertion is used.

Deleting Records from the Current Database

If, over time, a particular solution is discontinued or altered and its database entry becomes obsolete, it is possible to remove that entry from the database. Such a removal would most easily be accomplished while in the list-display format. Once the record to be deleted has been listed and located on the screen, all of its contents may be selected by pointing to the small box to the left of the record and clicking the mouse. The entire record, once selected in this manner, will appear highlighted on the screen. It can then be deleted by selecting the "Clear" command from the "Edit" menu. A word of caution -- Works does not provide a warning before it executes the "Clear" command so make certain that the correct record has been selected and that it should, indeed, be deleted. If a record is mistakenly "Cleared" from the database and you want to get it back, there are two ways to proceed. First and most simply, you could choose the "Undo" command from the "Edit" menu. This would just reverse the previous "Clear" command and the data would reappear as if nothing had happened. This would be the method to use if you immediately realized the accidental deletion and no other commands had been executed after the "Clear" command. A second strategy that could be used even after additional commands had been executed would be to close the database and allow
Works to prompt as to whether the edited changes should be saved to the disk. In this case, the answer to the Works prompt would be "No." This method could potentially lose other edited entries but at least you would be back to the original database with the accidentally deleted entries preserved.

Searching the Database for Records

One of the most useful features of Works database functions is the ability to locate specific records or specific items in records without having to scroll through each separate entry. Works has the ability to look for either a single, specific record containing a desired item, or a group of records which all contain the desired item. This can be done by using either the "Find Field" or "Match Records" command.

Find Field Command

To have Works search for a single occurrence of specific information, use the "Find Field" option under the "Organize" menu, or press "Command-F" on the keyboard. When this option is selected, Works then displays a dialog box that allows you to type in whatever information is the object of the search. For example, to search for products in the database which contain Edetate Disodium, first, select "Find Field" and then type this item into the dialog box and press "Return" to start the search. When the "Find Field" search successfully locates the first product containing Edetate Disodium, the resulting display will only be of that individual record. This manner of display is in contrast to the "Match Records" option which will be described shortly. Since only one record is displayed at any given time, the "Find Field" command must be carried out again and again to find subsequent occurrences of this same information. However, it is not necessary to retype the search criteria to locate the subsequent listings. After each occurrence is located in the "Find Field" command, an option is presented which allows the search to be either continued or suspended.
The other option presented in the “Find Field” dialog box is the “Search Text Fields Only” option. Currently, this option is turned “on” in but it really doesn’t matter whether it is turned on or off in the Contact Lens Solutions Database since all fields contain only text.

**Match Records Command**

To have Works search for multiple records which each contains the desired item, use the “Match Records” option. This option is also found under the “Organize” menu or it may also be selected by pressing “Command-M” on the keyboard. Again, a dialog box will be displayed for you to type in the item to be searched for. When “Return” is pressed, the search begins and when completed, Works (in the list-display format) will simultaneously display all records which met the search criteria. For example, if Edetate Disodium were again the item being searched for, all products which contain that ingredient would be displayed at once.

**Matching Multiple Record with Selection Commands**

Works also has the ability to match and select multiple records based upon multiple criteria as opposed to the single criteria of the “Match Records” command. To use this feature, choose the “Record Selection” command from the “Organize” menu. Again, Works will display a dialog box with two scrolling menus at the top of the box. The left scroll will contain the field names from the Contact Lens Solutions Database while the right scroll will contain the various rules of selection criteria.

Start the record selection process by scrolling through the left menu and highlighting the desired field name to be searched. Next, scroll through the right menu and similarly highlight the search criteria to be used. As before, if there is a specific item that is to be searched for, this will have to be typed into the “Record Comparison Information” entry bar. Once the multiple matching rule has been assembled, click the mouse on the “Install Rule” option at the bottom of the dialog box and Works will then display the
newly created rule in the dialog box. Up to five additional rules of search criteria may be similarly entered if so desired. Each of the multiple rules can be implemented on an inclusive or exclusive basis. That is, there are “And” or “Or” options which can be chosen for each subsequent rule. The “And” option restricts the number of records that get selected while the “Or” option expands the number of records selected.

Finally, to implement the rules into an actual search of the records, press “Return” or click on the “Select” option located at the bottom of the dialog box. After this has been done, Works will display that subset of records which meets the multiple criteria of all selection rules.

For example, imagine that you wanted to list all lens-care products which contained the preservative Polyquad and which also contained Tween-21 as another ingredient. To match records for both of these criteria, select the “Record Selection” command from the “Organize” menu. Once Works displays the dialog box, select the field name “Preservatives” from the left scroll menu and then select “Contains” from the right scroll menu. Next, type “Polyquad” into the “Record Comparison Information” entry bar and click on the “Install Rule” option. The first selection rule is now complete.

To enter the second selection rule, begin by clicking top-most “And” option in the dialog box. From this point on, the steps as just as they were for the first rule. Select “Ingredients” from the left scroll menu; select “Contains” from the right scroll menu and type “Tween-21” into the entry bar. Again, click on the install rule and then press “Return” and Works will search for and then display that particular subset of records which meet both of these criteria.
CONCLUSION

With the contact lens solutions data arranged as a Microsoft Works database it is possible to easily access and retrieve particular information when it is needed. Moreover, the Works program allows for the information to be searched, sorted and manipulated in various ways at the discretion of the user. This turns out to be an excellent way to keep track of the great volume of information concerning contact lens solutions. It is hoped that this database will prove useful in both the clinical and academic setting.

Anyone desiring to make copies of the data contained in the Contact Lens Solutions Database is welcome to do so. There are no copyrights or restrictions place upon any of the data. Copies of the data may be retained or distributed to others in any manner that proves useful.